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Fi ST e IR A o BT iR AF (REST)

—s  JTFRERNE

R A N AR S B N A& AT T i e /D BRI 23 BH7 K 2 AT — AR S ORI 54T 4
TG Az AR IREEIRR, Juk D — AR AR S50 HE R I EOR D7 vk R 42
TR X PR, B3] EH 2 R IhRERE R i f% (functional magnetic resonance imaging, fMRI)
PPN (Ogawa et al., 1990), BEAELE AATULEE 2K Mo 2544 SCRE L AATTI 2R i 5 49 1) B — 348
BT BA % € e (Clare, 1997). fMRI ML AL L4 K- ##6i: (Blood oxygen level
dependent, BOLD) 155 1224k

H AT TA TR SRR 22 H i Dl 8 A0 AL Tl 6 AT 45 sl g 42 i, I [R]INF 53 547 45 sl 3k
FHRY (AT 0 2 B B AR R 2875 3)) B840 R AF 21 1R o AN Hubel R Wiesel FL AR (1) 505,
FIAE M B AR SE e, ER UL A TV AR D i o il 1 B i IR Bl
PR AZ B EAT, X a7 5 PR 25 RS STty K 1) BOLD A5 AR Ak ml DA A& i A K i 1)
SE DX B B 1 AR DX MR DM 1) LI e R A 51 45 A6 R T 12 K (Fox et all,, 2007) 6
TR PP TAT S5 BB S 50y X — e A T P47 (General linear model, GLM ) 57
T A AR, A AE YT R R B X, AT RO I R D &g

Open Closed Open Closed Open Closed Open Closed

1. 5% IMRIESFEEEX 2 BERARTESEXFMEM TR B E N KZER BOLD 5.
(5] H Foxetal.,2007)

XHESIRAS IMRI B8 1 20 B AR PE, 508 DAL — AR A 4K SPM (Friston, 1995)
s AFNI (Cox, 1996), IXMANFAFHR AT LUSERI 5T 18 77 (L T GLM B2 K 20 A7 F Adh BRAT:
SIRASTA MR Bl . il 2 R ELHE 2 AT R GLM B, WF5T 8 T SR AR B 1) 2
WV, BRI & s, SRR #F SPM (Friston, 1995) ¥ AFNI (Cox, 1996)
AT AR 5 {5 A v A2 AR S R RO RS 3 R B 52 4 AR R R DX, BRI T 45 )
HOPERT I T 0T PR X o



Fi ST e IR A o BT iR AF (REST)

i ( X B
b= = .J =
H = ““""m + H
....... : |
: X B,
fMRI Signal = Design Matrix x Betas + Residuals

2 . BiE 2 MEHIEE GLM &2
(518

http://www.ssc.uwo.ca/psychology/culhamlab/jody_web/fMRI4Dummies/pdfs_and_ppt/GLM_E
XPRESS_fMRIJCM_ay2004_bwe6.pdf)

{HZ GLM AR oy B 156 2 A8 F R Ak o, X AR AR H & BOLD 15 5 i
BJCIEARRE, HEMEERAREE . T Fox et al. (2006) % L 1 & ) BOLD 15 5 1 LLZ 35 M it e — 30
SPAEATSS 2 L) BOLD 155 3 5l, FHIA LSS5 E R F & ¥ BOLD 15 5 M sh#E A\
L EE .

Biswal et al. (1995) RILLEEA B IS HMESIRAS T, K Ze A0 1y Jekeit 3 20 X RTA i)
EAIEF) X L B)IX A BOLD {5 I s AHEEHHOC, Ui BRAS TRXMRFLLN). AX
[¥) BOLD 15 ‘S BN A ZERENIE A, &A@ il TH MR ARSI 2
{54 AN, JE Ay Bl BEETI . TR A P 00 A e DX R R R I AT 55 AR
PERITESIRAK (Raichle et al, 2001). AHEE TAESARES T, e a0 E ML EE SORES T IX L8
X R ILIT E TG ER . Greicius et al. (2003) W90 A ILE BT a0 Bl mrdnas bl m .
TG RUAH P S X ) BOLD {55 i EAH G, Ui W IR LI X A1 i SR T 1 H R 3))
ARSI —300E, AR REERE, MR — A DIREM S . X8 ST B R I A 2355 3
P SIENAZ . AR . PREFE S Z D) RE A % (Raichle et al., 2007). #fEA fMRI
CLER A I T 8 hh 20 K5t s I BIF 5, Bt )L 35 v S kB 2 B B A (Attention-Deficit
Hyperactivity Disorder, ADHD). Pi/R2z¥#:2K [ (Alzheimer’s Disease, AD) 4%, Zang
etal. (2007) RILiFHEA T ADHD WA MU FHl. Ao ueiz g e XU NG A iy [b]
HUE . X35 30 5 . He etal. (2007) KILERFEA AD B 1787 51 1) H &G 3 5 1E
R PR AR LU B B B AIG . 28 BRI, BFUER RSN B 3G S0 BLAR AP 22 D Re A S 2
Xo Gihb, #EA MRl —BOESEH D B, BT R E AT, ANTR R AR 40 1) 5
Wvevh, WA ERA S Y, BRI 2 i e R AL, W R S AR
HHERALS, WAL, T2 0. RERMB, K& RS IMRI AR L
s ARHE S IR LRI N H .

H AT A B v O kT A S T A S . SiANIE A R — Bk

(Regional Homogeneity, ReHo). fkAliJ<IE (Amplitude of Low Frequency Fluctuation, ALFF).

M7y 53 8T (independent component analysis, ICA) %5757, REST H Ay HIRRAS i 58 InA
2



Fi ST e IR A o BT iR AF (REST)

TRVEASCIhREE R 7k ReHo J7vE LK ALFF J5ik.

LA DR FR B IMRI WFSC N ) 2 T, B SRR BOGERIX 3K (Region of
interest, RO Z[ME# ROI 54T FIAR R Z M AMEARDCREL, b HIKE 5 RO
TEINRE A S s P ARRIYE , BRI T D R4 . IXPh 5 vk T8 . R &) T3 % (Fox et al., 2007)

ey il — Uk (Zang et al., 2004) &AL — & 454 T DI REX N AHAB K Z 1) BOLD 15 = B I (1)
A HAT AL, T 2R RE R 5L (Kendall’s coefficient of concordance) 1 4 #8545 K &
HoANBNIARER (74 19 AL 27 MEAFRD Z RN TE P2 ) — 3k . ST
WL, Ja+aral (Posterior cingulate cortex). W FTAH (Medial pre-frontal cortex) LA XU
I F /M- (Bilateral inferior parietal cortex) X JLANN X F I HIAT 25 A4 S M A S B0 (task
independent deactivation, TID), JfH., & EA& PET WL AT, X LA X A £E 4 i
) (Raichle et al., 2001). 1K H ReHo J5 vt 58 &K I, Jadn47 el (Posterior cingulate
cortex). WA (Medial pre-frontal cortex) LA XU TH /Nt (Bilateral inferior parietal
cortex) 7EifEAIRA T 1) ReHo (HH W= T2 g{T 55K (Zang etal., 2004). FE— 50K
W, 4IRS, XL 1) ReHo fH{E4 i i = (He et al,, 2004). A&, XM
s ReHo BFFTHI 45 R Raichle S5 45 A& — U . ReHo J7 ¥4I N - 545 ADHD (Zhu et
al., 2004; Cao et al., 2006). Fifi4>%LhE (Liu et al., 2006). AD (He et al., 2007) LL & Z4EA,

(Wu et al., 2007),

LA I "(Zang et al., 2007) ¥ S A5 BOLD 15 5 7EARAIE [l A o A7 AR B LI,
i — A0 (0.01~0.08Hz) PA T e s M AR P SRR Zm —AMA 2= E TS 30 1)
559, MBEE LRI T SRR LIRS T B ARESI AR EIK. DAL, A
WP L PATR PR b 2 A T I DX IR R A AR K 22 5% (Yang et al., 2007), it BIERAT IR 42
A Tf DAX 433 A AR BOPR A o A FAIRR IR FE R A0, 72 ADHD JLEE Y, A7 U4 [ (nferior
frontal cortex, IFC)~ /N BT [F] 2086t 32 50 52 J2 < S0 i #5657 %5 (Zang et al., 2007),
FHLAHTXT ADHD [RIAFFT 45 5 2 — 2 .

SRIMBLAE BT — N IALT SPM - (Friston, 1995) B AFNI (Cox, 1996) FHKAFAE WS (E A
FEE AR T7 A 0] i AR o o 2235 30 B A AR S (R VST VR REAT 20 B I A B i RS WA AT
25 Vet A SIS R BT CAAS B8 $2 A0 0 B 1) D X FRUE 45 s 1R Ak 217 R A sPv

(Friston, 1995) B AFNI (Cox, 1996).

DN REZERE )7L LM AFNT (Cox, 1996) SK5EN%, 22 HEBL, X— Kt
Kud, TR . R S e R rT LU A ReHofMRIL.0 (by Dr. HE Yong, free
download from http:/www.bic.mni.mcgill.ca/users/yonghe) KAt 5, {H AR FEx it AL
P (R AP o AR MR ¥ 77 2 A i B 1) A FEE R 23 i LS fMRIBOLD {5 %, BUARTHS R B JF A
2%, WA DER ARNI SRSEIL, RS0 A B0 S 2 R BRI ) i 2 o

RS MR — SROE SR B, A AR € TS5, AT B 3RS 40 1 S5 Wit
WATEGR SN, HESR G e F e R R, SO 5 5 5 B R4 A Hi A T
%, WABESIE, ST 290 KFERRWGT, X2EffEA MR IREGE It s, JE%
T I AR ISR F o 25T H RS B — IR B sl TR n] BALEAE G038 7 (5 b A
XL TR A AT AL BEER S AR MR B, 5SS FMRI s 434 T EL A5 (Resting state fMRI data
analysis toolkit, REST) NI TFsK M TP A . REST J&T MATLAB, %1-%FT#f 84 tMRI E 110 Hr
WP R, RHETEH P A E S 28, v 2 A NMEEE. BT, REST 1
FEDRe T T — B 1R D Thaeid s "M Eds 7 7% - fMRI Es b 2 — R ]
O3 NI RO DL K ST =AY B, V2 I D) RERE SR R AR (n SPM
FUARND fEHFE A B A A KPS O ARH 5835, JTLL REST B I AKX P 43 PN 25

3



http://www.bic.mni.mcgill.ca/users/yonghe

Fi ST e IR A o BT iR AF (REST)

BATHEK . REST W] LUMEANRIZA R SIS MR (AT 2 PEAR G ReHo DAL ALFF
SRR TR B MR s . AN, REST MY SR IR TR ki, 2:2k
PEERFS ROI A RE SR BRI ROI Y-~ B3 I [1) F 471 L #5415 5 AR o7 T8 10 I i) 1 R B 433 |
BHELHBIIERE)

= BB R

)EH@
PRV B, i S A D) e A I 54 1 23 B R A 3L
Y NGISE
1. RAEJEH P S inkhe g5 24
2. flbEibs
3. EHHT L ReHo. ALFF. ZRPEAHSG,
4. TRALER: HOEIER . FLIEERS;
5. H&E: BRUFESENT AN T AR E S50 H & S0F, DOR T it
ATRERT
6. HE:
a)  EEAEMEREINRTH. DR,
b) RIS L L BA S PRSP
c) fMRI gty BRI DR EEI A G BN, SR 4R R,
d) MGt t Bk AAL BB Brodmann A5 HEEHR G AL KR BITAE R B i
INEEAG IR LI ).
JFRES: MATLAB (FiliA: 6.5, 7.3)
fRA5474k: 11528 (REST iliAs: 1.0, Hitrid 20071213)

=, wit5%E

FHEAGEEN P RS HICE . Otk ER R gD g R A S0

(=) 3£

1. B RS E: 41 Guide /723 (reho_gui. alff gui. fc_gui. rest_ROIlList) Fl
] m 3CA4 (rest. rest_SliceViewer. rest_powerspectrum. rest_progress. rest_waitbar.
rest_SetROI. rest_SphereROI) PiF 7,

2. B EFER: reho. alff. fc. rest_bandpass. rest_detrend.

3. M4t R REEIR A : SliceViewer. 2% MRIcro [¥I# Bl BUIHIAT AFNI R — 25 D)5 56 o



i i)

2007 /12 /18
2007 /12 /15
2007 /12 /16
2007 /12 /17
2007 /12 /17
2007 /12 /17
2007 /12 /17
2007 /12 /17

Fi ST e IR A o BT iR AF (REST)

4\

IR

% ReHo 4, A EHCRIIREFEERAT 7 X ulE D BRI A MR SRR T 50, IR
Pew TR

v RGAFUEL JEDG. ALFF. MM ZAF Bl (EHT ARSI H 2% Windows —

Wk B2 GeEE H s e H 3%, 41 €:\DOCUME~1\ADMINI~1\LOCALS~1\Temp\? Linux —

BN H s /tmp) FE 3 JRVHSE (BN 4 2, I ERRUAR SR8 A7 B4 A5 000 A 2k 55

5%

UpeY

. AFN 1, RS R S PPl DR PEAk 67 5
MARIT e
RESTI5 A
ZE W Kl 7[R A OC R AL

e 0.01-0.08Hz, TR=2s A ER 9 A
H LR Az 2 0.9857 40.0995 eI
ThReE B GAAR, ENILTIPS JeF T 0.0187 1 JeHlT
M NI6,57,39)) A A5G, L5 kB e F 0.02 1 e
ISR 0.01-0.08Hz, TR=2s A ER 2.6546 0.9973 JilT
JrB—E: 27 voxels JeF 0.00094717 1 i
B DL A= w3 (E JeF 0.0000039824 1 e
Fisher's 2754t e F T 0.0848 0.9756 JEflF

ﬂ\

fEFHEK

1. HHT REST Frig b 2R ) 5L 202 ANALYZE 7.5 4% X

® LIRATH sPm2 TRALFEE S, AL RSO E ANALYZE 7.5 4%, AT Bk

® UIRATH] SPM5 TRALERELHE, KOMSE A S NIFTL A%, . v LU
MRIcron Bff7#H) dem2nii.exe Fll dem2niigui.exe K 5¢ 8 B 4% 28 i 8%

® LURATH AFNI TRACEREHE, BG4 R SCF 2 4D 1) BRIK/HEAD #%3X, 7 B4 4k,
A MEH MRIcro Sk 5S¢ B i X 1) i 46k

2. EREMEER. PR IIGEE ;. ReHoy ALFF IN), REST DASCH:3 Ky ifr, %
KA RS A EE Y 3D M G S (BN 3D i G SR R — AN i
)55 ELlnFH sPM S8 EE T 3L s, A Z04EAN TG 2 REST TSI SCF Clnfic itk
Jo HE RS con_0002.img 5D ST RS H A FE 2E REST LR SR — A
HSCpE e

3. FEVESEZRMEAH G, i N A [ A BR DA e BT, o BT N

B A bR D LS R AR BB IE A AN EAE 52 XL RO sl View ROIVRZAS
g‘Fo



RS RER IR B 7 AT AR AF (RESTD

4. 3|HA: RESTing-state fMRI data analysis toolkit (REST, by SONG Xiaowei,
http://resting-fmri.sourceforge.net)

N ERTTIEER

SR A, A SPM2. SPMS5 Bl AFNI HEAT S AL EE,  FRRE B0 SCAR AR R
ANALYZE 7.5 #3205, #nl UTAGAE] REST HEATIHEL T

¥ REST FIr{E H ki IN 2] MATLAB HIEA2 5, 1E MATLAB T4 % A rest RIT]
HEE 3.

! REST 1.1

Resting State fMRI Data Analysis Toolkit

noratory of

ReHo ‘ ‘

Functional Connectivity

& 3. REST BxiFWER T


http://resting-fmri.sourceforge.net/

Fi ST e IR A o BT iR AF (REST)

(—) WHIRER

M REST 5L (& 3) 3L+ functional connectivity (IhREIER:), ML ThHEE RN K B

g 4.
! Functional Connectivity - 0O x
Option; Femove Linear Trend
[ ] detrend
Option; [deal Band Pass Filter
[] Bandc Hz) e TR: (=)
Ihput Parameters
S
e
Data Directory: [:]
— Set ROI Marzk
(%) Defautt mazk () ko mask
) User's defined mask
Covariahles: Q

Functional Connectivity ‘ Do all ‘
Output Parameters

Prefis: FCMap Fesult: Prefix_DirectoryMame {hdrfimg ;

Directory: A TLAE wvarkaui_Reholreho_v Q

Fizher Z-scare transformation within the mask(zPretfix_Directoryiame {hdrimg

Manual Operations

Help ‘ | Fisher £ ‘ ‘ Slice Wiewer ‘ ‘F‘uwer Spectrum‘

4, e EFITER®

e s, Ml Do allAE LB MR I UERE GEAFA 0.01~0.08Hz, TR=2s) Z
5, LR R AR A (<2, 51, 27) AERL, KRR 10m m HIERN S
N 8] P SRR T~ () P 1), TE IS A RN AR 2R (A DG R H i SO FCM ap fE

7



Fi ST e IR A o BT iR AF (REST)

HAr s, AU HE SRR AR DANTemp H X T CAH M S RA
FCM ap test Contro Fl.im g/hdr N FCM ap test ADHD-1.im g/hdr N
zFCM ap test ControFl.in g/hdr. zFCM ap test ADHD -1.im g/hdr), Wl:

! Functional Connectivity - O x

Option; Remove Linear Trend

cietrend Detrend

Option: Ideal Band Pass Filter

Band( HZ) om w005 TR: (=) 2 Filter
Ihput Parameters
230 Do WA TLABwWorkMzU_Reho'Reho W1 'SampleDatatest Contral-1 -

230% DoOMATLAEwWyork U _Reho'Reho 1 '=ampleDatatest_ADHD-1

W

Data Directory:  [IATLABwWeorkWGUI_RehoReho_1'WSampleDatatest Control-1 Q
— et RO hask

(#) Defautt mazk i) Mo mask

Covariahles: Q

) User's defined mask

Functional Connectivity ‘ Do all ‘
Ot Parameters
Prefix: FChiap FChap_test_Control-1 {hor e

Directory: CuiTemp [:]

Fizher Z-score transformation within the mazk(zPrefic_DirectoryMatme {hdrfimg 1

Maniual Operations

Help ‘ | Fisher £ ‘ ‘ alice Wiewer ‘ ‘F‘Dwer Spectrum‘

5. TR EEERINE TR

AFIPBRCERF R (=2, 51, 27) BIJIEE s Voxel Wise, SR M4 [n] T 4 & AP+
AU L AL 425 Covariables — F2 & % KOR ¥ A WS INAE AT P A8 B 5 ‘Fisher Z-score
transformation ... "i% 1 K 43 B — A ¢ R EUIN VIR R I b XA RH G 2R EUN A R
Fisher Z-score Jl&; JEAESCAFAETIN 172 YEAFIEE: N —2ainT LUHIX L5 1 (B 5 111
&t B2 J& zZFCM ap _test Control-1.im g/hdr. zFCM ap test ADHD -1.im g/hd1)
AT SRS



Fi ST e IR A o BT iR AF (REST)

(=) HEER—B

M 3——REST T AL+ ReHo, HILTHE =3 — 2k it B R S i 6.

! Regional Homogeneity

Option; Remove Linear Trend
[ ] detrend
Option; [deal Band Pazz Filter
[ ] Bandi Hz) "~ TR: (=)
Input Patarmeters
~
w
Data Directory: E]
L Cluster hazk
() 7 voxels (%) Defautt mask ) Mo mask
(19 voxels ) User's defined mask
(%) 27 voxels
ReHo | Doall |
Output Parameters (ReHao magp)
Prefix: Rehotdap Fesult: Prefix_Directoryhame . {horfmo
Directory: DA TLAE wvorkisU|_RehoiReho_1 iSampleData E
Divide ReHo brain by the mean within the maskimPrefix_DirectoryMarme {hdrfimg ¥
Manual Operations
Help ‘ | Divide Mean ‘ alice Wiewer ‘ Fower Spectrum ‘

6. BE—HMEITERE

B 7 R Do alaAE 4IRS . BB (G874 0.01~0.08Hz, TR=2s) ZJ5,
PL27 AMEZE N — AN, 1] i ask MNI61 73 61.n g” ANALFEMNALU— D m ask)
PEH B E X moask SRIFEH RS, b SCIHEH RehoM ap /E RIS, I
g R (C 7 BB F P B S RS R RehoMap testControtl.in g/hdr o
RehoM ap test ADHD -1.in g/hdr N m RehoM ap test ControHl.im g/hdr N
m RehoM ap test ADHD -1.in g/hdr ) i 17 B
D AM ATLAB\work\GUIReho\Reho VI1\Sam pleData\out H3¢~, #l:



Fi ST e IR A o BT iR AF (REST)

! Regional Homogeneity -

Option: Remove Linear Trend

@leziens

Option; [deal Band Pazz Filter

[+] Bandt Hz) 001 | e | 008 TR: (=) i Filter

Input Parameters
230% DM ATLAEwWyork WU _Reho'Reho 1 'SampleDatatest_ADHD-1 e
2308 Do A TLAEwWorkhEU_Reho'Reho 1 'ZampleDatatest_Control-1

v

Data Directory:  |DopaTLABwvorkwEUl_Reho'Reho W1 SampleDatattest ADHD Q

L Cluster Mazk
() 7 voxels () Default mask () M mask
(18 voxels (%) User's defined mask

()27 voxels | aBwvorkiGll_Reho'Reho_ Y1 maskimask MH_E1_ 7361 img Q

ReHo | Doal |

Output Parameters (ReHa map)
Rehobap_test ADHD-1 {hdriimg

Prefix: RehohMap

Directary: D MATLAE workizU|_RehoiReho_1iSampleDataiout Q

Divide ReHo brain by the mean within the maskimPrefiz_DirectoryMarme {hdrfimg ¥

Manual Operations

Help ‘ | Divide Mean ‘ ‘ olice Wiewer ‘ ‘F‘nwer Spectrum‘

B 7. it BE—BIERER

Hrr Divide ReHo brain by the mean ... %6 1 R 7R 15 21— J5 30— S0P A 1) [R) I 2 61X
A JRF SO R LA mask WIRBAME, JRAESCARAETIN L "m YEA TS T iR LA
Hax s g8 50 (& 7 67 i4 K4 & mRehoM ap test Contro H.in g/hdr .
m RehoM ap test ADHD -1.in g/hdr) TSI .

10



Fi ST e IR A o BT iR AF (REST)

(=) HERBRIE

M 3——REST F: S LR ALFF CIRARIRD, BT AR R i 1 BB S an il 8.

! Amplitude of Low Frequency Fluctuation - 0O X
Option; Femove Linear Trend
[ ] detrend
Option; [deal Band Pass Filter
[ ] Bandi Hz) e TR: (=)
Ihput Parameters
-
-
Data Directory: Q
Mazk
() Default mask () Mo mask

) User's defined mask

Band Hz) 0.m e | 005 TR: (=] 2
ALFF | Doall |

Output Parameters (ALFF map)

Prefix: ALFFhiap Result: Prefix_DirectaryMame {hdr firmc

Directory: DoMATLAE wvorkisU|_Reho'Reho_1iSampleData [:]

Divide ALFF brain by the meat within the maskimPrefic_DirectoryMarme {hdrfimg 1)

Maniual Operations

Help ‘ | Divide Mean ‘ ‘ alice Wiewer ‘ ‘F‘Dwer Spectrum‘

B 8. Kikizit EHRE

7EE 9 Sl Do all”BHfE I ERIN m ask KiHEE 0.01-0.08H z (TR=2s) X Ja] ARHHR
g, i SCPERER ALFRM ap fEMETSE, JREPTA AR (B 9 MplFrmERESR
ALFFM ap test Contro}l.im g/hdr N ALFFM ap test ADHD-1.mm g/hdr
m ALFFM ap testContro Fl.im g/hdr + m ALFFM ap test ADHD-1.m g/hdr ) ff & %
D\ ATLAB\wotk\GUIReho\Reho V1\Sam pleDatalout H3&F, l:

11



Fi ST e IR A o BT iR AF (REST)

' Amplitude of Low Frequency Fhﬂ:tllati*‘
Option; Remove Linear Trend

[ ] detrend

Option: [deal Band Pass Filter

|:| Band (Hz) 0. | 05 TR: (=) 2

Input Parameters

230# DoWATLAB Wy orkMEUL_Reho'Reho %1 'SampleDataitest ADHD-1 -~
230% Do ATLABwWyorkMzU_Reho'Reho 1 'SampleDatatest_Contral-1

W

Data Directory: ATl aBwworkyaUlRehoReho_W1\SampleDatatest_ADHD-1 [:]
Mazk

() Defautt mazk i) Mo mask
) U=er's defined mask

Detault

Eandi HzZ) 0m 005 TR: (=) 2
ALFF | Doall |

Cutput Parameters (ALFF map)
Prefix: ALFFhap ALFFhap_test_ADHD-1 {hdrimo

Directory: D MATLAE warkizLlReho'Rehno_1iSampleDataiout E

Divide ALFF hrain by the mean within the mask (mPrefiz_DirectoryMatme {hdrifimg 1

Manual Operations

Help ‘ | Divide Mean ‘ ‘ olice Wiewer ‘ ‘F‘uwer Spectrum‘

B 9. itE KMk IEaE =~

Hrp Pivide ALFF brain by the mean ... 5% H R/ 73 21— AR MR X 7 [7] B 280X S
GG I s 5 LA G mask P I3AME (I 9 I 7 rh 1R & ol s B AT AR 32 (308, g
Wi sk, AW m ask), FAESCAEARTINE " m YEATTSE: AR5 F— 2 uin] LU x e gh
BCHE 9 B Mg K S & mALFFM ap test ControH.in g/hdr
m ALFFM ap_test AD HD -1.in g/hdr) SRMZEHHRE: .

12



RS RER IR B 7 AT AR AF (RESTD

. RN

(—) &% REST

1)

2)
3)

REST 1z 1T I BEEIK

a) MATLAB. fi## MATLAB 2006b (WindowsXP), [Xl}j REST 2007 &7t MATLAB2006b
(Windows XP) RFITF& . MATLAB 6.5 (Windows XP). MATLAB2006b (Linux) £
MR A

b) Z/b>1G WAF.

o) BEETHEEZ /DY 1024 X 768

N ECEI REST ALV %2 Fest_ B Ja & U 1. tar.bz2, W1 Pest_20071129.1639.tar.bz27

fRIEAE R A H R, WInXA H3% MATLAB [)#4%: MATLAB -> File -> Set

Path... -> Add Folder...->Save->Close.. 1 L4 28547 B REST fiiAS, W26

A LART IR RRAS

(—) 14 REST

M MATLAB % %2 1 #iHl B REST FT #F H % : MATLAB -> File -> Set Path... ->
Remove->Save->Close, #XJ&MIER REST Frde H % .

(=) )83 REST

1.

2.

Ji5 MATLAB.

7E MATLAB [¥)fir 4 & I N “rest” (1K 10)

rdow Help
= B 7 Current Directur‘g:éd:\MATLAB\wnrk
4 a o o
irb ............................ Toolbox Path Cache read in 0.09 seconds.
é """""""""" MATLAB Path initialized in 0.64 seconds.

To get started, select MATLAE Help or Demos from the Help menu.

= > rest

I

& 10. 7 MATLAB & & O i “rest” LA EI REST

o M MATLAB ) L HAEH A 5): i MATLAB Start -> i Toolboxes ->

13
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iEFE "Resting State fMRI Data Analysis" -> 5 17" Start REST 2007" (1% 11)

14



=+ MATLAB 7.3.0 (R2006b)

File Edit Debug D

'& Aerospace

0 ﬁri & B B < 4 Bioinformatics
Wnrks-pace 4, Comrmunications

5 | 4 control System

® o e . Curve Fitting

Matie = 4\ Data Acquisition

4 Databaze

4 Datafeed

) Distributed Computing

4\ Filter Design
o Filter Design HOL Coder

4 Finandial

<\ Financial Derivatives

. Fixed-Income

4\ Fixed-Point

4\ Fuzzy Logic

4 GARCH

4 Genetic Algorithrn and Direct Search
4 Image Acquisition

o Image Processing

. Instrument Control

ER Link for Code Composer Studiottm)
4 Link for Modelsim®

4\ Mapping

4 Model Predictive Contral

4 MATLAR

4
4
4
r
4
r
4
4
4
4
4
4
r
4
r
4
4
4
4
4
4
4
4
r
4

 dAMATLAB Wwork

Aidow

th Cache read in 0.09 seconds.
th initialized in 0.64 seconds.

ed, select MATLAB Help or Demos from the Help menu.

Model-Based Calibration
Meural Network

Qpc

Optirmization

Partial Differential Equation
RF

Resting State fMRI Data Analysis
Robust Control

SPM

Signal Processing

Spline

Statiztics

Symbolic Math

Systemn Identification
Virtual Reality

& Start REST 2007
@ Help

@ wail to REST Author

R R T XXX XA X T XX

* w w w w wv w v willw w w w w w

Simulink
Blodksets

W
W
shartouts »

=
b=r;

Desktop Tools »
web »
Preferences..

Help

4 Demos arkspace |

]
]
]

<]
B
#) Find Files...
e
¥
4

§tart]
11. M MATLAB T E#§ B%h REST

ke 3 Ei RS fMRI s oA TR R B K 5

15



Fi ST e IR A o BT iR AF (REST)

(T4) £ REST PR EAFAEAEE H =X

FELLNEETERS . B IIREERE . it — Sk, RHRIERT, REST RASCH Iy i
B, BRSO N RS R AR BRI 30 MBSO CREAS 3D il BB SR xR — NI [
Ko HTH] SPM SE AR TAL B G, A ZFEANTT 2 REST THELI SO Cln e A2 1
con_0002.img %5) MICAESR AR sl U /T 5 REST H LA SCHTRCE— AN Fr i Sk v
ATUAER 12 Fros X h s on/ml s — R 508 H ok, SeBltb R 5.

Input Parameters

b

Data Directory: E]

B 12. 7£ REST FiREWMASE: Rm/Mir—RIBER R

sl SR s I — AN H k. el DL IHHL S In— AN BRI 1 H 3%
e 12 H a2 X el s A 5k $% Add recursively all sub-folders of a directory;” #& 13.
R EE DL BR AN RIS IR H 3%, v AN B i s e MR, thn] DA B Del”
B Backspace WL LB ITH L4 H 3k, W LA P $E Clear all data directories?

Input Parameters

LS

Add a directory "

Data Directs.~ Delete selected directory E]
Clear all data directories

13. BIEN— 1 EF FORETE S

(f£) Mask HIixE

H =P mask: ERIAF mask. TG mask. 7 EHE X mask, W& 14. {1 mask
2Af REST HUHEE mask N IIER 2, S PRt S
Maszk

() Default mask ) Mo mask

() Uzer's defined mazk

CeTernpirnask_MM_E1 _73_61 img E]

B 14. E=Z#MEXEH mask PIEAE, FEHRREABPBEEXH mask
16
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“D:\Temp\mask_MNI_61_73_61.img”,
® RN Mask CJLELEfANZIZD:
B Voxel Size=3x3x3, Dimension=61x73x61;
B Voxel Size=3x3x3, Dimension=53x63x46;
B Voxel Size=2x2x2, Dimension=79x95x69;
B Voxel Size=2x2x2, Dimension=91x109x91;
® /T HE X[ mask:
B LR AON TR img/hdr ) ANALYZE 7.5 4% X SCA
B DU mat SO CREA T AAUE mask);
B OBOETT A SRR, . DR

(N) 7E REST FiX B SH

REST it ZHHE AT TS5 RAAATBOH 5. TR mask WM Cif ReHo Al
ALFF I 5D BUR A z-score (D)fgiEde), Wil 15, & 16, Kl 17,
Output Paraimeter s (ReHo magp)
Prefix: Rehohap Result: Prefix_DirectaryMarme {horfirme

Directory: o A TLAB wvork

Divide ReHo brain by the mean within the mask{mPrefix_DirectoryMarme {hdrfima 1)

B 15. £ REST RiREMES . BHEB—HiE.
Output Pararmeters (ALFF map)

Prefis: ALFFMap Result: Prefix_Directoryhame {hotfmo

Directory: of: A A TL A B wvork

Divide ALFF brain by the mean within the mazk{mPrefix_DirectoryMarme {hdrfimg 1)

16. 7E£ REST HigEMESH: KRG,

Output Parameters
Prefix: FCMap Result: Prefix_Directoryhame {horfmo
Directory: D:MATLABIWDrleUI_IEﬂDWREhD_W "SampleDats |
Fizher Z-score transformation within the mask (zPrefiz_DirectoryMatme {hdrfimg 1

17. 7 REST RiREMHSE: hEEER

® UZ: REST S AN H 3148 7R L v S8R R LAk IXAN 50 B % it 5
B, Bilan, EHANESE H 2" c:\data\ OneCleanDir" , 7& REST tF&5ea, WRMRAT
POEMHATS L "ReHoMap" 1%, THE 4544 4 & "ReHoMap_OneCleanDir.img/hdr" .

® th Ha: HEVHEAIRI IR E

17
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IR, JETRERLL mask WEME ORIFESbE . AR, WP 15, [ 16): ik,
K S5 B SCPE PR DAL Mask A FRIESE, I B RTEE " m" CRAF R LA 1
TR fln, T —A ReHo /& "ReHoMap_OneCleanDir.img/hdr", T4 [
LI (¥) ReHo i SC1F44 7 /& "mReHoMap_OneCleanDir.img/hdr", 5 B4 E -2 i)
ReHo map fRAF{ER— A HE T

TIET, JEREARA z-score (IhREMERE, WK 17): & b, BT EAEE
FRHEA N z-score:

1+r
1-r

z=0.5log

I ERTSE  RAE AR S VA R i, TR A DGR BU
"FCMap_OneCleanDir.img/hdr", 8454 it S04 44 502
"zFCMap_OneCleanDir.img/hdr", L5564 fif 1) FHOG R BN IRAFAE [ — A HR R o IR
AR REGERE, MWOPHARRIFES N b £7R75%, IFARAF z-score FEFEA AN txt A

P&

(L) M. ELTES

°

REST W] DIi— 28 pAb #E A T4, than e thisits . JE3:, i 18, 19.

Option; Remove Linear Trend

[] detrend

18. FlIAIN: EZ&MiEH

K 18 H, ik I Hetrend T, FKon fith Do all”fG &6V IhREE B ol /il — BUPE Bk
ARRIE 2 F 5 25 BRI AT Has i e MR A

Kl 18, & I Betrend LT, Kl 18 HAIART Detrend "fH A Ay vl H, Holi b di
T B S N B ER H 5% 25 BR Gt A%

B S A R H s B4 " _detrend”, TR AR EHE H % [F— NS H . i,
HiNH L "c:\data\OneCleanDir", 7EXLFRZEMIER G, SO F A A A1 EPL G

18
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f# 1% 3 "c:\data\OneCleanDir_detrend" F 1l . W R E XL HER Z B,
"c:\data\OneCleanDir_detrend" B 2 F &£, B2 ExXBF S E EM KB A X
"c:\data\OneCleanDir_detrend" R )5 FE{RFE R ER G ETE .

ZEHAIE, REST I LZMEEE S AFNI h LM (3dTeat —rit+) FUSE RS RILT L —
FERT, ILDY L 9

(J\) A& I

REST 1] LM — e £l TAC PR TAF, bhanerbEms . seuk, Wik 18. K 19.

Option: |deal Band Pass Filter

[ ] Band (Hz) "~ S: (=)
B 19. WEIR: JRiK
® [ 19, ¥ F Band (HZ2)) Frnmidi Doall” G 7evh 5 I feiZE Rz ul 7 3l — 20 sl A
IR0, fEEEMER )G (R CLE I detrend 135D X AT A B HEATUE I -
e K 19+, i I Band (HZ)™EIE, K 19 ALK Filter 414 vT ], ol b4l
%0 BT A N s H SR uER .
o iR AR R HSE EnJS g " filtered", AR H M E—ANCH S NI, @,
AN HJE "c:\data\OneCleanDir" , 7EZFREMIER G, K PA R RS EPL EHE
& F #|  "c:\data\OneCleanDir_filtered" F 1f . W B 74 J& W 2 @7 ,
"c:\data\OneCleanDir_filtered" © £ 7+ 76, W 4 A ¥ & 8 & Wk B %
"c:\data\OneCleanDir_ filtered" %R )5 FH{RAF LI 5 I EHE
® LAl — N A EE i 0.01~0.08Hz [l P ALEE, ZF1 AFNI 3E3 (3dFourier
—retrend) FJZERLEXS, KRINGEH LT 2 —FEH .
o  HHTHIARRFIE VRS : WAEUESRESE [, I HUE SR A AR O AR A
o AT EIARELE ER: : mOAEO AR AU, I HARSE AR R T . Wi 20,
JEW VO 0.01~0.25Hz (0.25Hz & KFEHIHI 42—,
Cption: Ideal Band Pass Fitter
[#]Band( Hz) | 001 | e~ ol TR (1 | 2 Filter
20, IBAESIBIERK
®  HATPIARMIGE E R - MRAE AR MRS, Jf H s e AR K& Wi 21,
JEPE L & 0~0.08Hz,
Cption: Ideal Band Pass Fitter
[+] Band( Hz) 0 E - | 003 TR: (=) 2 Filter
21. IBAEIRIEER

19
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(1) FEEH-EBHTESERRE

JRI TR EEAE T AR R (A3 D A IRERREZE — MR (7 4, 19 ek
27 MEE, W 220 WINTRPSIAAGK— S0, w RUSBR S DI RE DX AN 7] 1A 5% (1 I )y
N AR . dnlEl 24 by IEAE THS R — Bk

22, HBH 7N (FEARRELETEARIRMN 6 MEFR). 1910 (ZREPBEARAR
THI 8 MEFR) . 27 NMARM L —HIR

_ Z(R)’ — n(R)’
N
EK‘(HJ —n)

AR 1. BERMERAITELAN, WESERMERY, M"ToM1ZE; REFiNHER

W

(n+1) xK

B9#F0; R =
e E .

L Cluster
)7 woxels

=MA R BE; K E—1THARRBEEFFIEE (K=7, 19, 27); n

19 voxels

(%) 27 woxelz

23, FE—BUtit BRE hERKX/NEIRE

20
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Option: Remave Linear Trend

[] detrend BEFORE Filter detrend AFTER Fitter

Current progress:
Option: ldeal Band Pass Fiter 1 Calculate the rank of time series

[¥] Ban( Hz) | 001 |~| 008 | TR:(S) wai...
| |
Input Parameters 1

2304 H: keighehdrcd ] wo_xiaochunien_fitered_detrend B0% Elapsed 0:5:54, Remain 0:3:46  18:268:31 Started
2308 H: wighehdrice d_givweigang_fitered_detrend |
230# H:wighethdrc o wd_rrushufang_fittered_detrend |
230# H:wiehethdrc o] wid_lihuangouo_fitered_detrend
230# H:wiehethdrz o wd _zhaoxianli_fitkered_detrend

230# H:wiehethdrcd! wd_nivsitong_fitered_detrend
230# H:wiehethdricd! wd_guajianying_fittered_detrend

) EeHo Computing

Diata Directary: | H:wiehethdricd! wd_sisochunfen_fitered_d Tnta_l Rrogress. .
H:hxiehethdricdwd_lthuangguo_filtered detrend
L Cluster task
() 7 voxelz () Default mask () Mo mask [ |
() 19 vozels () Users defined mask 21% Elapsed 0:43:5, Remain 2:34:43  17:49:21 Started ||

() 27 voxels |--:-gram FilesMATLAER 2008 workimask_MNI_ET_73_61 jmg | E ‘

ReHo

Outpt Parameters (ReHo map)

Prefix: reho_vd_xisochunfen_fitered_detrend {

Directory: | H: beiehe et |E

Divide ReHao brain by the mean within the mask(mPrefix_DirectoryName Jhdemeg })

Manual Operations

Divide Mean Slice Yiewer Power Spectrum

[ Help l
B 24. 5& “Doall” FEHBEITERE—E

(+) &SRETHES R E

LEVHEARARIEIN , 75 2EBE UK AT 58 (41 0.01-0.08Hz) FIRAFEMIKE (RITRD, &l
25, {%41"Band Hint" 52§27~ MR "SE b 2 55 oS MR Y . SR oh SN A e g i
AP 5AN 2, SEPR 2 5 T SRRV S B BN — BTN 2257 CSEBn 2 5T SRR
V0 A TR IR) TR RN ] SR E 25 AT i R I )P 1 E AT AN
AT

Eandl Hz) 001w~ 005 TR: (5] 2 Band Hint

B 25. R5nkiE T E SHRIRE

(t—) ZThREEZSHHIBE

VR IhReER:, FEBE RO MR (WERE AR RMIE). REST FRALM AT E INEE
R Voxel wise (T ROI Fil mask W&/ MAZAHC) F1 ROl wise (IFHEMANELZ

21
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A ROI ZIAIRAHIR ). REST [ DIREIER VAL LA ARNI (1) 3dfim+fir & LLAL, JLFRAT
ZEst, WYL WA

1. EX ROI:

R D REE R L S A Y VYoxel wise "4 415X ROI List BT S 1HI ) Add ROI 4L (4
DRI KB E ST ROl wise” 3% AT HIIL ROI List BB S, anl& 27) nlHIE X
ROI (IS0, Wik 26, REST HHu LAsE X — K& ROI: (1) Fh-1 &4 ROI, 58— NERFEIX 45,
T AR SR E s (2) MASK 2BAE) ROI; (3) BFE)JFA. i, MASK 81
ROI LA LAY A28 rpsg e (1) MGeit t Buk F IR A BB R B (ERN ] — 52
BIEJE), (2) M AAL BEHGEEER E X, (3) M BRODMANN FEMESES @ ikilX, (4) M
FH P A E ) MASK SCA o ] 18] 2 41 D6 2502 AATE XAF I — A txt SCARH, I HG I [A] 7
HIAK S N AZ RS EPL ISFIE] 41 5 BOH D

miih Next”f24lE X, A Done tZ 4 5¢ % ROI ) %€ Mo

! ROI (Region of interest) Definition - O x

R

—{ ) Seed ROI

Define a zeed RO by zetting the center coordinate and the radiuz(mm)

—() RO
There are 4 methaods to generate the ROl mask file:

(1 1. From statistical t-map by selecting cluster atter thresholding
{:- 2. From &AL template by selecting specific area

l:'::- 3. From Brodmann template by selecting specific area

{1 4. From uzer defined mazk file

—{_) Time courses

Uzer defined time courses contained in &t file

Dione H iew ROl Mesd

B 26. EXROI

22



RS RER IR B 7 AT AR AF (RESTD

) ROI Definition List

.S
b
iz L
[ Dione ] [ vmme0|] [DHHEROI] [ AddHOI:
& 27. ROIFIF, =i “ROI wise” FRIHI; A LA XA F EIZEUIEZE B9 ROI B 1465 (8] 57

5,

REST S HFI AR 5 SCAF AT LUJE txt A AT LU 1D SCAFCN ARNT A3 1 s TR 4710,
REST BV N S BB —FIE h — AR &, P4 H BT REST A S — Wkt 8 — ANk i B
AW, MARMN BRI EEAAR, Bl G A2 EriE, REST H AT S #r
— R AR Dh e IEE: (W R & A Eh AR &, REST whn] LL— U2 AN N Th R iEED) .

a) {EEX ROl JG, @EBEH View ROl IhREEFH — T e XA ROI J& A 78T A
A

b)  FEE SUFIF A ROI I, REST SAEIEM X YCATE RS 423D, i) X A e
IAT T Sy A, T SR BT AL TR EPI RSB I L A B D48 IE R IR i

o) AR EE XA, REST ETHEL A G T & ERIA M T L 4
PP E A, BT AFNI 1K) 3dfim+  -polort=1 fir 4.

(+=) /A Do al”FiEitE

middi Do all”JFA TR i — B0k (RPRi . DhREER:, WIRIFINE b 7 L2 Mg
BE YRR, WSEXT I MR L e MRS, R TIE R AR T IR A A L S ik
Rk ARPIRIE . DhREER) TR

TR P B R, R 2 F ok, B om PN HERE 4%, — AN a0 H %
MITHSEBERE, — AP H R TSRS, R P ASEERE SRR N AR N R4 s (]
24, xiidi Doall”E Fha v H R E— k).

23



Fi ST e IR A o BT iR AF (REST)

(t=) FrHET

JAHLES: CPU A Intel® Celeron® M 1.6 GHZ, N7 512MB, #4133 4200rpm.

MR ESE: —/ NN, 230 AN AT

A MATLAB: 2006b (v7.3).

1. B&MEER: — MR —aeAt .

2. PEW: A AW

3. JAEE gtk AN RS O RREES . IR,

4. ARSENE: —ANAPISB S ORE LEMEER . B,

5. IhREIEHE: Voxel Wise #ixl, — /N AN—2380 /5475 ROl Wise #38, —/NMA 30 B A4y OAN
T REGMES . JEPO.

(HIEHEHETLR

WEFT ). FEIBREL mask WIEEGE T80 A0 X R BN z-score $TF REST 1)

SliceViewer. ErAIFNE, i 28. K 29,

Manual Operations

‘ Help ‘ | Divide Mean

‘ alice Wiewer ‘ ‘ Fower Spectrum ‘

B 28. FahiflE: ERTHEB—HME. KMREERITER@E.

Manual Operations

‘ Help ‘ | Fisher £ ‘ ‘ alice Wiewer ‘ ‘F‘uwer Spectrum‘

29. FRE: EATHREEERITERE.
® Divide mean——Fx LA Mask N IF3M(E: EHRERE— NI E 45 (W ReHoMap.hdr/img
B0 ALFFMap.hdr/img) &, ¥2 Br DU B9 mask PIRISME, 45 DL“m” R T S AR A7
TEFT IR ST BT AE I H 5%
® Slice Viewer: LT MRicro, FTLAHIKEH ANALYZE # UG IEAZHLEL, 2 2300
(AT LL Montage), &Nt 4 RIS, &G ROl FEHCUHT AUITLER Overlay 1)
Cluster i mask, P& f& & s (]P0 f Dy 2, Wil 30.
HER:
a) {E REST MABbR G, MEMAI KA, EGADLAIEE, BEGALAAE: Wbk
KIE, BGaHahIEME, BUgEdh i NIREE, BUE BiahiEdE, &
A A
b)  REST FEAXS Jsiafy EUG AT Js i 2 R A
o)  JITAE I REAR 20RO ) SO e RS — 3 A S AN SO 2 MNL JBERR 1)
UV AZAE REST HE MNI AR 4 R4 A\ SCI2 Talairach BRI TE, Y %A%

24
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REST " {#H Talairach FEFx .

d) SliceViewer 1A LU AN BEFRZE Underlay [IEFR, 24HT Overlay F#))8 45 a] LL A ids
Click to Toggle Hdr info G 5 G - 734F, P AR 2 A5 45T Underlay 1) Voxel
Size M4 LN HahEE, #ELER Overlay S N3 FE-—"N AL (Underlay)

I+, IXFE Overlay A1 Underlay I JFEAREEAT T 1] FRLFR6E Y. 6 2R
JRERR I Eﬁ_% T
) Slice Viewer —— REST 1.1

Click to Toggle Hdr info

Slice Viewer

[Jwoke Crozzhair
Ximm)  Y{mm)  Z(mm)

0 -E0 kil

Fal w MITal.. »

79 71.00282

Underlay:  w [ |

shiolreho_v 1 Template=h2 img

Overlay:  w [ |

Wowerlay _Testtemp_0000.img

See Overlay
Threshald 0.23371

Il | * |
Template  « | Save2mask

|
(=]

|
L]

-0
-1

|
o

. 002
.82t
. 84¢
. TBE
. 68C
. 611
- &30
-t
L3TE
. 298¢

.23z
.21¢
. 402
-1
=T
.65¢
. 134
82¢
-2l

W H Overlay ]

& 30. REST HY SliceViewer, FJLASKIUIE ZHLE . Montage. Bt tEHRERER TE.
Power Spectrum——IJ)3%& i 4 Slice Viewer, W LA REFH 5 voxel 1 & T,
PAAGXAS voxel (RN TR R4 H 2. PRGBS DM s Hk (&S IE D T
TR — AN IhEES, RIGARETFEAEH Slice Viewer T FFIX /N IRER, SR oK Slice

Viewer b F55E ARARAE I D AW AN F) 2 (B 31D
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58
s sl s
s

Amplitude

]
s
T

Resting State fMRI Data Analysis Toolkit

REST 2007 -

) DAMATLAB\work\GUI_Reho\Reho_V1\SampleData\Raw20070514\

Power Spectrum after removing linear trend

' 0.08 Hz
1 Dawnivel Song
Copyright 2007-2010
al rights reserved

Shice Wiewer

Yok

X1 v

=

I / 1 I
0.05 01 015 02 025
Frequency( Hz), Sample Period( TR)=2 seconds

i
a0

¥ z
a0 | 108

Size: 18121 7181 Intenstty: 73

S

=~

Bl
:

3

Intensity

B

2a0f

Time Course(Green dot line is after removing linear trend)
T T T

Dawnwei Sang
Copyright 2007-2010
il rights reserved

\
50
Rermove Linesr Trend Bafore Power Spectrum  11me( seconds)

130,30 37) Time Course:

L | | L L TRE =) 2
100 150 200 250 300 Band( Hzj: 0.01~0.08

Slice Viewer

‘Yoke

tean=1258.03, std=7.89459 X2 v

3 ¥

<

a7

EE]

Manual Cperations

Workspa I I

] I Divide Mean ] I Slice Wiewer ] lpnwer ‘Spemruml

Size: B1x73x51 Intensity: 1254

[# Start]

31. 7£ REST A& id SliceViewer & FH15 E FEfR & A BIET (8] 751 F0Th 2R 3%

I\

PR Ui B

1. WzwyE. (http://lresting-fmri.sourceforge.net)

a)

b)
c)
d)

REST F#;
(http://sourceforge.net/project/platformdownload.php?group_id=197363)
REST ji_ﬁ (http://resting-fmri.sourceforge.net/)

REST Wi H Ui (http://sourceforge.net/projects/resting-fmri)

REST XA [ 1 55 704t

(http://resting-fmri.sourceforge.net/index REST Codes.html)

a)

b)
c)
d)
e)
f)
g)

SRR A, A AR R AR T AR A HARRSE L MATLAB 1)y 4 %
DA AT 147 NREE SEIL— IR — N A ReHo Mo AR BUK I A2 7 1 5
fili b, A8 F B SR G B 24 8B T i v 55 REST 325 ANALYZE™
7.5 A& CEI Img/Hdr ST 1 R 8 A 2 BOK I 1), FAUE B 1 3
T2 AR IS bug (B2 ARTEARS T P4 IR

SR 2 K P B AT 25 3. logo (ReHo).

TR T e B AR W SR g A S

SR e P AR LA LRI e S .

R T U SR U S G S ST R L P BT B B R A B AR
SRR TS e 5 B SCRS BT

U AFNI, REST MDhREZEERE. RHHRIE . LV . B ARSI AFNI

KA, 45 RIEA LA AFNUAHIE s 5340, 25 7 AFNI AR 2 A CAY .
26


http://resting-fmri.sourceforge.net/
http://sourceforge.net/project/platformdownload.php?group_id=197363
http://resting-fmri.sourceforge.net/
http://sourceforge.net/projects/resting-fmri
http://resting-fmri.sourceforge.net/index_RESTCodes.html
http://resting-fmri.sourceforge.net/index_RESTCodes.html
http://www.mayo.edu/bir/PDF/ANALYZE75.pdf
http://www.mayo.edu/bir/PDF/ANALYZE75.pdf
http://www.mayo.edu/bir/PDF/ANALYZE75.pdf
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h) & MRIcro, REST /i) Ch2. Brodmann. AAL itk K HAd a1k | T

MRIcro; [z %% (auto balance) [S2El i idtA F2MHHE MRIcro 1)
FH) (http://mmww.mricro.com/dicom.html#contrast) K52 %1

FRAS 52 REST ‘223 H s&\man\history.txt 1.

alffm 1.1
alff_gui.m 1.1
alff_gui.fig 1.1
reho.m 1.5
reho_gui.m 1.1
reho_gui.fig 1.1
rest_readfile.m 1.1
rest_writefile.m 1.1
rest.m 1.1

rest_DivideMeanWithinMask.m
rest_bandpass.m
rest_detrend.m
rest_loadmask.m

rest_misc.m
rest_nextpow2_one35.m
rest_powerspectrum.m
rest_progress.m
rest_sliceviewer.m

rest_to4d.m

rest_waitbar.m

Xiao-Wei Song
Xiao-Wei Song
Xiao-Wei Song
Yong He, revised by Xiao-Wei Song
Xiao-Wei Song
Xiao-Wei Song
Yong He, revised by Xiao-Wei Song
Yong He, revised by Xiao-Wei Song

#20071008 Added functional connectivity tool

rest_mni2tal.m
rest_tal2mni.m
rest_spm_matrix.m
rest_ROIList_gui.m
rest_ROIList_gui.fig
rest_SphereROl.m
rest_SetROl.m
rest_ReadLutColorScheme.m
fc_gui.m

fc_gui.fig

fc.m

rest_Corr2FisherZ.m
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README.txt 1.1 Xiao-Wei Song
logo.jpg 1.1 Xiang-Yu Long
icoTransverse.jpg 1.0 MRIcro
icoCoronal.jpg 1.0 MRIcro
icoSagittal.jpg 1.0 MRIcro
icoOrthogonal.jpg 1.0 MRIcro
Template/aal.hdr 1.0 MRIcro
Template/aal.img.gz 1.0 MRIcro
Template/aal.lut 1.0 MRIcro
Template/aal.txt 1.0 MRIcro
Template/brodmann.hdr 1.0 MRIcro
Template/brodmann.img.gz 1.0 MRIcro
Template/brodmann.lut 1.0 MRIcro
Template/ch2.hdr 1.0 MRIcro
Template/ch2.img.gz 1.0 MRIcro
mask/reho_mask02.mat 1.0 Yong He
mask/reho_mask03.mat 1.0 Yong He
mask/reho_mask12.mat 1.0 Yong He
mask/reho_mask13.mat 1.0 Yong He
info.xml 1.0 Xiao-Wei Song
man/AFL.txt 1.0 Xiao-Wei Song
man/history.txt 1.1 Xiao-Wei Song
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